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ABSTRACT

Of all the renewable energies, solar energy is the only energy gained its popularity and

importance quickly. Through the solar tracking system, we can produce an abundant

amount of energy which makes the solar panel’s work ability much more efficient. The

main control circuit is based upon Arduino micro controller. Micro controller is

controlled this system by programming. Here also use an Arduino Pro Mini, Buck

Converter, LDR Sensor, Servo Motor. The main task of this project is that when the sun

reflects on this solar panel, it will charge and save its battery. The LDR sensor then senses

the direction of the sun and moves this solar panel automatically. We worked with dual-

axis experimentally, stationary solar, and single-axis solar experiments to compare, and

finally, we found dual-axis efficiency is more than others.
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CHAPTER 1

INTRODUCTION

1.1 Background
Industrial and domestic reliance on the use of fossil fuel is today facing

challenges in demand environmental consideration. Dual Axis floating solar panel follow

the sun continually and provide constant power output throughout the day with high

efficiency by doing azimuth & altitude tracking. 40-50% more energy. 15% more yields

due to the cooling effect of water. In Bangladesh, there are huge unused coastal area,

pond, canal, and 57 major rivers that will be effective for dual axis floating solar PV

Estimated 1,500 ��2of ponds, Bangladesh has immense potential for dual axis floating

PV.

1.2 Problem Identification
Solar power, which is available only in fixed installations, is the major problem. The

ability of power that can be generated is restricted as part of this issue. The other factor is

that the solar tracking system's purchase price is very high for a family that uses more

electricity than normal, so more than one solar panel will need to be installed to generate

enough power.[1] So, this concept is all about solving the problem that is going on at 180

degrees, this solar tracking system will detect rotation. So, compared to where the solar

panel stays in just one direction, the solar panel mentioned here is extremely large. [2]

Solar energy faces another problem.

Usually fixed solar energy panels would not be directly oriented towards sunlight as a

result of the continuous motion of the Earth. If the consequence of this system is that it

does not achieve the highest efficiency.[3] The solar tracking device is the larger solution

for achieving full output power due to this method. This is the primary reason that why

the project for the solar tracker is implements. The solar tracker must obey the sunlight in

order to get additional power output. The cost of purchasing more solar panels is,

indirectly, likely to be reduced. In order to manage sunlight, these devices also slowly

take the time users need to change the position of solar energy.[4]
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1.3 Motivation
The world's advanced nations are currently working on renewable energy. It is necessary

to work with renewable energy to give a beautiful world to the next generation. Our

government has also received small projects on renewable energy sources. So, we want to

do something about renewable energy sources. As such, our country is a landless and

densely populated country. One thing we have seen is that many countries are

successfully producing solar power from floating solar power plants.

1.4 Aims and Objectives
We have some specific objectives for this project and they are pointed below:

 To design and build a Dual Axis Solar Tracker System.

 To taking notes from our real-time test.

 To follow the position of the sun for maximum energy efficiency.

1.5 Thesis Outline

 Chapter 1: Introduction. This chapter is all about background study,

problem identification, motivation and aims and objectives.

 Chapter 2: Literature Review- Here briefly describe about floating solar

panel project, its advantages, disadvantages, application and some live floating

solar panel project.

 Chapter 3: Evaluation of the Developed System - This chapter is discussed

about instrument and software. Hardware and Software details and its working

procedure.

 Chapter 4: The Design Method and Process – Here briefly discuss about

project methodology, Block Diagram, circuit diagram, required instrument

cost analysis, working principle, work plan, output curve analysis etc.

 Chapter 5: Conclusion – This chapter is all about our project advantages,

limitation, application and this project conclusion.
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CHAPTER 2
LITERATURE REVIEW

2.1 Literature Survey
This literature review reveals the detailed work that has been carried out till date on the

topic of Solar Tracking. N. Othman, M. I. A. Manan, Z. Othman, S. A. M. Al Junid have

designed a two-axis sun tracking system with the use of five LDRs and an Arduino nano

controller [1].

The objective of this research is to design and construct the automatic dual axis solar

tracker for maximum sun energy utilization. The only point of worry is that this system

should consume energy as minimum as possible so that the difference between power

conversion and power consumption would increase and hence the net profit of the system.

Arduino UNO controller has been used and it is programmed in C language. LDRs are

used to detect the maximum sunlight position in the sky and the program written performs

calculations and drives the servo motors to make PV panels perpendicular to the sun [2].

The sun not only travels from east to west but there is a change of angle in north to south

direction also. So the north and south directions should also be taken care of. Dual axis

trackers do that. These trackers track the sun on a horizontal as well as vertical axis.

Because of this operating ability the dual axis trackers have more output power than the

single axis trackers. Light Dependent Resistors are used to find the brightest spot of the

sun in the sky. LDRs are connected to Arduino UNO controller which gets to know the

position of the sun in the sky and hence rotates the motors towards the sun[3].

Two Servo motors are used for panel rotation which also fulfils the low cost and

lightweight criteria [4]. Md. Tanvir Arafat Khan, S.M. Shahrear Tanzil (2010) have

designed and constructed a micro-controller based solar tracking system using LDRs to

sense the intensity of sunlight and stepper motors to move the Photo-Voltaic (PV) panels

in accordance with the sun [5].

Fabian Pineda, and Carlos Andres Arredondo (2011) have designed and implemented a

two-axis sun module positioning by sensing the maximum brightness point in the sky. A
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geodesic dome based sensor has been built for the bright point tracking [6]. Authors

Salabila Ahmad et al. have designed and constructed an open loop two axes sun tracking

system with an angle controller. The hardware is selected such as it will maximize the

power collected and minimize the power consumed as the efficiency parameter lies in

between these two power parameters [7].

Solar tracking also helps in transmitting sunlight to dark area like basement. Authors

Jifeng Song et al. have implemented the high precision tracking system based on a hybrid

strategy for concentrated sunlight transmission via fibres [8]. Author Cemil Sungur (2008)

has presented the multi-axes sun tracking system with PLC control. The azimuth and

altitude angles of the sun are calculated for a period of 1 year at 37.6º latitude where

Turkey is located. According to these angles, an electromechanical system which tracks

the sun according to azimuth and altitude angle is designed and implemented [9].

Authors A.chaib et al (2013) have presented the heliostat orientation system based on

PLC robot manipulator. It is presented that by mounting certain no. of heliostats and

facing them towards central power tower water can be heated and turbines can be driven

for energy conversion purpose. By applying MATLAB program for determining the sun’s

position for heliostat orientation and by using PLC robot manipulator it is presented that

maximum amount of energy gets converted from solar to electricity. Concentrated Solar

Power (CSP) is used in this experiment [10].

Authors Tao Yu and Guo Wencheng (2010) have introduced automatic sun-tracking

control system based on Concentrated Photo Voltaic (CPV) generation. CPV generation

works effectively when light panels trace the sun accurately. Stepper tracking control

technology is used. This control relies on control circuit with ARM and camera which can

provide powerful computational capability [11].

Shreyasi Chakraborty. Nilanjana Mukherjee. Rashmi Biswas in 2017. Due to their many

benefits, renewable energy sources are becoming one of the top priorities for today's

world. In particular, to meet our ever-increasing energy needs, solar energy is emerging

as a potential source of inexhaustible and unpolluted energy. However, solar panels,

which are fundamental components of the conversion of solar energy, are installed at a
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certain angle and with diurnal and seasonal shifts, are unable to track the direction of

sunlight. Using a micro-controller combination, we built a solar tracking system[12].

To meet our ever-increasing energy needs, solar power is emerging as a potentially

inexhaustible and non-polluting energy source. Arduino prototype driven automated solar

tracking system is primarily designed using Arduino Micro-controller, LDRs, and stepper

motors Three phase motors are typically used to transfer solar power based on the

accumulated incident light controlled by LDRS[13].

The software controls this solar panel's vertical tilt point, and it rotates horizontally. Then

according to the sunlight incident, it could follow the direction of the sun, not just the

vertical rotation as well as the horizontal rotation of the solar panels. This system is

therefore capable of optimal lighting and can minimize the cost of electricity production

by providing a minimum number of solar panels with proper alignment with all

sunlight[14].

Rathika Kannan. Kavitha S in june 2017 Solar tracking system was made with stepper

motor tracking system to increase the efficiency of output power of the PV plate. Solar

energy is becoming ever more an alternative energy source. It is a device that tracks a

solar array's rotation, so it is always associated with the direction of the sun Developed

and mounted in this article, the solar tracker offers a safe and inexpensive way to align a

solar panel with the sun to optimize its energy output. In the proper orientation the solar

monitoring system is configured to align the photovoltaic solar panel with the sun for

direct radiation[15].

Ankit Anuraj Rahul in 2018. As an important tool for renewable energy, solar energy is

increasingly rising. Solar tracking helps to collect more solar energy, since a profile that

is perpendicular to the sun's rays can be maintained by the solar panel. Whilst initial costs

are high for the implementation of a solar tracking device, this paper offers a cheaper

solution. The control circuit of the solar tracker relies on an ATMega16 micro-controller.

It is intended to sense sunlight through the LDR, and then switches with the stepper motor

to align the solar panel where maximum sunlight can be obtained. The stepper motor is

more controllable, more energy-intensive, more powerful and has good precision tracking

and little environmental impact compared to any other motor type[16].
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Shreyasi Chakraborty. Nilanjana Mukherjee. Rashmi Biswas in 2017. Due to their many

benefits, renewable energy sources are becoming one of the top priorities for today's

world[17].

In particular, to meet our ever-increasing energy needs, solar energy is emerging as a

potential source of inexhaustible and unpolluted energy. However, solar panels, which are

fundamental components of the conversion of solar energy, are installed at a certain angle

and with diurnal and seasonal shifts, are unable to track the direction of sunlight. Using a

micro-controller combination, we built a solar tracking system[18].

Thin Hiwe in August 2019. To meet our ever-increasing energy needs, solar power is

emerging as a potentially inexhaustible and non-polluting energy source. Arduino

prototype driven automated solar tracking system is primarily designed using Arduino

Micro-controller, LDRs, and stepper motors Three phase motors are typically used to

transfer solar power based on the accumulated incident light controlled by LDRS[19].

The software controls this solar panel's vertical tilt point, and it rotates horizontally. Then

according to the sunlight incident, it could follow the direction of the sun, not just the

vertical rotation as well as the horizontal rotation of the solar panels. This system is

therefore capable of optimal lighting and can minimize the cost of electricity production

by providing a minimum number of solar panels with proper alignment with all

sunlight[20].

2.2 Summary

From the literature discussed above, we gained a lot of knowledge and we inspired to do

this project. We were able to do it with everyone tireless work.
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CHAPTER 3

COMPONENT DESCRIPTION

3.1 Required Components and Software

Hardware

1. Arduino Pro Mini

2. Solar Panel

3. Buck Converter

4. Battery

5. Servo Motor

6. LDR

7. Capacitor

8. Resistor

9. DC Load

Software

1. Arduino IDE Software

2. Easy EDA Software

3.2 Arduino Pro Mini
The Arduino Pro Mini is a micro-controller board based on the ATmega328P. It has 14

digital input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, an

on-board resonator, a reset button, and holes for mounting pin headers. A six pin header

can be connected to an FTDI cable to provide USB power and communication to the

board.

Specification

 Micro-controller ATmega328P

 Operating Voltage: 3.3V or 5V (depending on model)

 Input Voltage: 3.35 -12 V (3.3V model) or 5 - 12 V (5V model)
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 Digital I/O Pins: 14 (of which 6 provide PWM output)

 Analog Input Pins: 6

 DC Current per I/O Pin: 40 mA

 Flash Memory: 16 KB (of which 2 KB used by boot loader)

 SRAM: 1 KB

 EEPROM: 512 bytes

 Clock Speed: 8 MHz (3.3V model) or 16 MHz (5V model)

Figure 3.3: Arduino Pro Mini

Pin Out

Each of the 14 digital pins on the Pro Mini can be used as an input or output, using pin

Mode(), digital Write(), and digital Read() functions. They operate at 3.3 or 5 volts

(depending on the model). Each pin can provide or receive a maximum of 40 mA and

has an internal pull-up resistor (disconnected by default) of 20-50 k Ohms. In addition,

some pins have specialized functions:

 Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial

data. These pins are connected to the TX-0 and RX-1 pins of the six pin header.

 External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt

on a low value, a rising or falling edge, or a change in value. See the attach

Interrupt() function for details.

 PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analog Write()

function.

 SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI

communication, which, although provided by the underlying hardware, is not

currently included in the Arduino language.



9

 LED: 13. There is a built-in LED connected to digital pin 13. When the pin is

HIGH value, the LED is on, when the pin is LOW, it's off.

The Pro Mini has 6 analog inputs, each of which provide 10 bits of resolution (i.e.

1024 different values). Four of them are on the headers on the edge of the board;

two (inputs 4 and 5) on holes in the interior of the board. The analog inputs

measure from ground to VCC. Additionally, some pins have specialized

functionality:

There is another pin on the board:

 Reset. Bring this line LOW to reset the micro controller. Typically used to add a

reset button to shields which block the one on the board.

See also the mapping between Arduino pins and ATmega168 ports.

Figure 3.4: Arduino Pro Mini Pin Out

The high-performance Microchip Pico Power 8-bit AVR RISC-based micro controller

combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM,

2KB SRAM, 23 general purpose I/O lines, 32 general purpose working registers, three

flexible timer/counters with compare modes, internal and external interrupts, serial

programmable USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6-

channel 10-bit A/D converter (8-channels in TQFP and QFN/MLF packages),

programmable watchdog timer with internal oscillator, and five software selectable

power saving modes. The device operates between 1.8-5.5 volts. By executing powerful

instructions in a single clock cycle, the device achieves throughput's approaching 1

MIPS per MHz, balancing power consumption and processing speed.
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Micro controller IC ATmega328p

Figure 3.5: Micro controller IC AT Mega 328p

3.3 Solar Panel
A solar panel is a set of solar photovoltaic modules electrically connected and mounted

on a supporting structure. A photovoltaic module is a packaged, connected assembly of

solar cells. The solar panel can be used as a component of a larger photovoltaic system to

generate and supply electricity in commercial and residential applications. Each module

is rated by its DC output power under standard test conditions (STC), and typically

ranges from 100 to 320 watts. The efficiency of a module determines the area of a

module given the same rated output - an 8% efficient 230-watt module will have twice

the area of a 16% efficient 230-watt module. A single solar module can produce only a

limited amount of power; most installations contain multiple modules. A photovoltaic

system typically includes a panel or an array of solar modules, an inverter, and

sometimes a battery and/or solar tracker and interconnection wiring.

Figure 3.5 : Solar Panel
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Solar cell modules produce electricity only when the sun is shining. They do not store

energy, therefore to ensure flow of electricity when the sun is not shinning, it is necessary

to store some of the energy produced. The most obvious solution is to use batteries,

which chemically store electric energy. Batteries are groups of electro chemical cells

(devices that convert chemical energy to electrical energy) connected in series. Battery

cells are composed of two electrodes immersed in electrolyte solution which produce an

electric current when a circuit is formed between them. The current is caused by

reversible chemical reactions between the electrodes and the electrolyte within the cell.

Batteries that are re-chargeable are called secondary or accumulator batteries. As the

battery is being charged, electric energy is stored as chemical energy in the cells. When

being discharged, the stored chemical energy is being removed from the battery and

converted to electrical energy. In East-Africa, the most common type of secondary

battery is the Lead-acid battery.

Specifications of Solar Panel

 Size: 4.4" x 5.4" / 110mm x 140mm

 Weight: 3 ounces / 90 grams

 Cell type: Monocrystalline

 Cell efficiency: 19%+

 2.27 Watts Peak Power

 Technical drawing

3.4 Transistor
A transistor regulates current or voltage flow and acts as a switch or gate for electronic

signals. A transistor consists of three layers of a semiconductor material, each capable of

carrying a current. A semiconductor is a material such as germanium and silicon that

conducts electricity in a "semi-enthusiastic" way.

Specifications:
 Bipolar Transistor, npn, 45v, to-92

 Transistor Polarity: NPN

 Collector Emitter Voltage V(br)ceo: 45V

https://github.com/VoltaicEngineering/Solar-Panel-Drawings/blob/master/Voltaic%20Systems%202W%206V%20112x136mm%20DRAWING%20CURRENT%202017%207%2020.pdf
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 Transition Frequency Typ ft: 300MHz

 Power Dissipation Pd: 625mW

 DC Collector Current: 100mA

 DC Current Gain hFE: 150

 Straight-lead housing

Figure 3.9: BC 547

Figure 3.10: Transistor Symbols

My intent here is to focus as exclusively as possible on the practical function and

application of bipolar transistors, rather than to explore the quantum world of

semiconductor theory. Discussions of holes and electrons are better left to another

chapter in my opinion. Here I want to explore how to use these components, not analyze

their intimate internal details. I don’t mean to downplay the importance of understanding

semiconductor physics, but sometimes an intense focus on solid-state physics detracts

from understanding these devices’ functions on a component level. In taking this

approach, however, I assume that the reader possesses a certain minimum knowledge of

semiconductors: the difference between “P” and “N” doped semiconductors, the

functional characteristics of a PN (diode) junction, and the meanings of the terms
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“reverse biased” and “forward biased.” If these concepts are unclear to you, it is best to

refer to earlier chapters in this book before proceeding with this one.A bipolar transistor

consists of a three-layer “sandwich” of doped (extrinsic) semiconductor materials, either

P-N-P in Fig below a(b) or N-P-N at (d). Each layer forming the transistor has a specific

name, and each layer is provided with a wire contact for connection to a circuit. The

schematic symbols are shown in Fig below (a) and (d).

BJT transistor: (a) PNP schematic symbol, (b) physical layout (c) NPN symbol, (d)

layout.

The functional difference between a PNP transistor and an NPN transistor is the proper

biasing (polarity) of the junctions when operating. For any given state of operation, the

current directions and voltage polarities for each kind of transistor are exactly opposite

each other. Bipolar transistors work as current-controlled current regulators. In other

words, transistors restrict the amount of current passed according to a smaller,

controlling current. The main current that is controlled goes from collector to emitter, or

from emitter to collector, depending on the type of transistor it is (PNP or NPN,

respectively). The small current that controls the main current goes from base to emitter,

or from emitter to base, once again depending on the kind of transistor it is (PNP or

NPN, respectively). According to the standards of semiconductor symbology, the arrow

always points against the direction of electron flow. (Fig below)

Figure 3.11: NPN & PNP Transistor Symbol

Small Base-Emitter current controls large Collector-Emitter current flowing against

emitter arrow. Bipolar transistors are called bipolar because the main flow of electrons

through them takes place in two types of semiconductor material: P and N, as the main
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current go from emitter to collector (or vice versa). In other words, two types of charge

carriers—electrons and holes—comprise this main current through the transistor.

As you can see, the controlling current and the controlled current always mesh together

through the emitter wire, and their electrons always flow against the direction of the

transistor’s arrow. This is the first and foremost rule in the use of transistors: all currents

must be going in the proper directions for the device to work as a current regulator. The

small, controlling current is usually referred to simply as the base current because it is the

only current that goes through the base wire of the transistor. Conversely, the large,

controlled current is referred to as the collector current because it is the only current that

goes through the collector wire. The emitter current is the sum of the base and collector

currents, in compliance with Kirchhoff’s Current Law. No current through the base of the

transistor, shuts it off like an open switch and prevents current through the collector. A

base current, turns the transistor on like a closed switch and allows a proportional amount

of current through the collector. Collector current is primarily limited by the base current,

regardless of the amount of voltage available to push it.

3.5 Resistor

Resistors are electronic components which have a specific, never-changing electrical

resistance. The resistor's resistance limits the flow of electrons through a circuit. They are

passive components, meaning they only consume power (and can't generate it). Resistors

are usually added to circuits where they complement active components like op-amps,

micro-controllers, and other integrated circuits. Commonly resistors are used to limit

current, divide voltages, and pull-up I/O lines.

The electrical resistance of a resistor is measured in ohms. The symbol for an ohm is the

greek capital-omega: Ω. The (somewhat roundabout) definition of 1Ω is the resistance

between two points where 1 volt (1V) of applied potential energy will push 1 ampere (1A)

of current. As SI units go, larger or smaller values of ohms can be matched with a prefix

like kilo-, mega-, or giga-, to make large values easier to read. It's very common to see

resistors in the kilohm (kΩ) and megaohm (MΩ) range (much less common to see

miliohm (mΩ) resistors). For example, a 4,700Ω resistor is equivalent to a 4.7kΩ resistor,

and a 5,600,000Ω resistor can be written as 5,600kΩ or (more commonly as) 5.6MΩ. All
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resistors have two terminals, one connection on each end of the resistor. When modeled

on a schematic, a resistor will show up as one of these two symbols:

Figure 3.12: Two common resistor schematic symbols

3.6 Battery
Lithium batteries are primary batteries that have metallic lithium as an anode. These types

of batteries are also referred to as lithium-metal batteries. They stand apart from other

batteries in their high charge density and high cost per unit. Depending on the design and

chemical compounds used, lithium cells can produce voltages from 1.5 V (comparable to

a zinc–carbon or alkaline battery) to about 3.7 V.

Disposable primary lithium batteries must be distinguished from secondary lithium-ion or

a lithium-polymer,[1] which are rechargeable batteries. Lithium is especially useful,

because its ions can be arranged to move between the anode and the cathode, using

an intercalated lithium compound as the cathode material but without using lithium metal

as the anode material. Pure lithium will instantly react with water, or even moisture in the

air; the lithium in lithium ion batteries is in a less reactive compound.

Figure 3.13: 3.7V Battery

https://en.wikipedia.org/wiki/Primary_Cell
https://en.wikipedia.org/wiki/Battery_(electricity)
https://en.wikipedia.org/wiki/Lithium
https://en.wikipedia.org/wiki/Anode
https://en.wikipedia.org/wiki/Charge_density
https://en.wikipedia.org/wiki/Zinc%E2%80%93carbon_battery
https://en.wikipedia.org/wiki/Alkaline_battery
https://en.wikipedia.org/wiki/Lithium-ion_battery
https://en.wikipedia.org/wiki/Lithium_polymer_battery
https://en.wikipedia.org/wiki/Lithium_battery
https://en.wikipedia.org/wiki/Rechargeable_battery
https://en.wikipedia.org/wiki/Cathode
https://en.wikipedia.org/wiki/Intercalation_(chemistry)
https://en.wikipedia.org/wiki/Chemical_compound


16

Lithium batteries are widely used in portable consumer electronic devices. The term

"lithium battery" refers to a family of different lithium-metal chemistry, comprising many

types of cathodes and electrolytes but all with metallic lithium as the anode. The battery

requires from 0.15 to 0.3 kg of lithium per kWh. As designed these primary systems use a

charged cathode, that being an electro-active material with crystallographic vacancies that

are filled gradually during discharge.

Product Specification

Voltage 3.7 V

Product Type Lithium-Ion

Battery Capacity 2200mAh

Weight 45 g

Model Number ICR 18650

3.7 5V Regulator IC
Voltage sources in a circuit may have fluctuations resulting in not providing fixed voltage

outputs. A voltage regulator IC maintains the output voltage at a constant value. 7805 IC,

a member of 78xx series of fixed linear voltage regulators used to maintain such

fluctuations, is a popular voltage regulator integrated circuit (IC). The xx in 78xx

indicates the output voltage it provides. 7805 IC provides +5 volts regulated power

supply with provisions to add a heat sink.

7805 IC Rating
 Input voltage range 7V- 35V

 Current rating IC = 1A

https://en.wikipedia.org/wiki/Electrolytes
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 Output voltage range VMax=5.2V ,VMin=4.8V

Figure 3.14: 5V Regulator IC

3.8 LDR
The LDR Sensor Module is used to detect the presence of light / measuring the intensity

of light. The output of the module goes high in the presence of light and it becomes low in

the absence of light. The sensitivity of the signal detection can be adjusted using

potentiometer.

Features:
 Adjustable sensitivity (via blue digital potentiometer adjustment)

 Operating voltage 3.3V-5V

 Output Type: Analog voltage output -A0

 Digital switching outputs (0 and 1) -D0

 With fixed bolt hole for easy installation

 Small board PCB size: 3cm * 1.6cm

 Power indicator (red) and the digital switch output indicator (green)

 Using LM393 comparator chip, stable

Pin outs:
 External 3.3V-5V VCC

 External GND GND
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 DO digital output interface, a small plate (0 and 1)

 AO small board analog output interface

 Can detect ambient brightness and light intensity

Figure 3.15: LDR

3.9 Arduino Software
The digital micro-controller unit named as Arduino Nano can be programmed with the

Arduino software IDE. There is no any requirement for installing other software rather

than Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to

the micro-controller on our board). The IC used named as ATmega328 on the Arduino

Nano comes pre burned with a boot loader that allows us to upload new code to it without

the use of an external hardware programmer.

Communication is using the original STK500 protocol (reference, C header files). We can

also bypass the boot loader and programs the micro-controller through the ICSP (In

Circuit Serial Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2

boards) firmware source code is available. The ATmega16U2/8U2 is loaded with a DFU

boot loader, which can be activated by:

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of

Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling

the 8U2/16U2 HWB line to ground, making it easier to put into DFU mode. The Arduino

Nano is one of the latest digital micro-controller units and has a number of facilities for

communicating with a computer, another Arduino, or other micro-controllers. The

ATmega328 provides UART TTL at (5V) with serial communication, which is available

on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the data. An
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ATmega16U2 on the board channels this serial communication over USB and appears as

a virtual com port to software on the computer. The '16U2 firmware uses the standard

USB COM drivers, and no external driver is needed. However, on Windows, an .in file is

required. The Arduino software includes a serial monitor which allows simple textual data

to be sent to and from the Arduino board.

The RX and TX LEDs on the board will flash when data is being transmitted via the

USB-to-serial chip and USB connection to the computer (but not for serial

Communication on pins 0 and 1). A Software Serial library allows for serial

communication on any of the Nano's digital pins. The ATmega328 also supports I2C

(TWI) and SPI communication. The Arduino software includes a Wire library to simplify

use of the I2C bus. Arduino programs are written in C or C++ and the program code

written for Arduino is called sketch.

Figure 3.16: Arduino Software Interface IDE

The Arduino IDE uses the GNU tool chain and AVR Lab to compile programs, and for

uploading the programs it uses argued. As the Arduino platform uses Atmel micro-

controllers, Atmel's development environment, AVR Studio or the newer Atmel Studio,

may also be used to develop software for the Arduino.The Arduino Integrated
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Development Environment - or Arduino Software (IDE) - contains a text editor for

writing code, a message area, a text console, a toolbar with buttons for common functions

and a series of menus. It connects to the Arduino and Genuino hardware to upload

programs and communicate with them.

Writing Sketches
Programs written using Arduino Software (IDE) are called sketches. These sketches are

written in the text editor and are saved with the file extension .ino. The editor has features

for cutting/pasting and for searching/replacing text. The message area gives feedback

while saving and exporting and also displays errors. The console displays text

Sketchbook

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store

your programs (or sketches). The sketches in your sketchbook can be opened from the

File > Sketchbook menu or from the Open button on the toolbar. The first time you run

the Arduino software, it will automatically create a directory for your sketchbook. You

can view or change the location of the sketchbook location from with the Preferences

dialog.

Beginning with version 1.0, files are saved with a .ino file extension. Previous versions

use the .pde extension. You may still open .pde named files in version 1.0 and later, the

software will automatically rename the extension to .ino.

Tabs, Multiple Files, and Compilation

Allows you to manage sketches with more than one file (each of which appears in its own

tab). These can be normal Arduino code files (no visible extension), C files (.c extension),

C++ files (.cpp), or header files (.h).

Uploading

Before uploading your sketch, you need to select the correct items from the Tools > Board

and Tools > Port menus. The boards are described below. On the Mac, the serial port is

probably something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo)

or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial
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adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4,

COM5, COM7, or higher (for a USB board) - to find out, you look for USB serial device

in the ports section of the Windows Device Manager. On Linux, it should be

/dev/ttyACMx , /dev/ttyUSBx or similar. Once you've selected the correct serial port and

board, press the upload button in the toolbar or select the Upload item from the Sketch

When you upload a sketch, you're using the Arduino boot loader, a small program that has

been loaded on to the micro-controller on your board. It allows you to upload code

without using any additional hardware. The boot-loader is active for a few seconds when

the board resets; then it starts whichever sketch was most recently uploaded to the micro-

controller. The boot loader will blink the on-board (pin 13) LED when it starts (i.e. when

the board resets).

Libraries

Libraries provide extra functionality for use in sketches, e.g. working with hardware or

manipulating data. To use a library in a sketch, select it from the Sketch > Import Library

menu. This will insert one or more #include statements at the top of the sketch and

compile the library with your sketch. Because libraries are uploaded to the board with

your sketch, they increase the amount of space it takes up. If a sketch no longer needs a

library, simply delete its #include statements from the top of your code.

There is a list of libraries in the reference. Some libraries are included with the Arduino

software. Others can be downloaded from a variety of sources or through the Library

Manager. Starting with version 1.0.5 of the IDE, you do can import a library from a zip

file and use it in an open sketch. See these instructions for installing a third-party library.

Third-Party Hardware

Support for third-party hardware can be added to the hardware directory of your

sketchbook directory. Platforms installed there may include board definitions (which

appear in the board menu), core libraries, boot loaders, and programmer definitions. To

install, create the hardware directory, then unzip the third-party platform into its own sub-

directory. (Don't use "arduino" as the sub-directory name or you'll override the built-in

Arduino platform.) To uninstall, simply delete its directory.
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3.10 Easy EDA Software
Easy EDA is a web-based EDA tool suite that enables hardware engineers to design,

simulate, share - publicly and privately - and discuss schematics, simulations and printed

circuit boards. Other features include the creation of a bill of materials, Gerber files and

pick and place files and documentary outputs in PDF, PNG and SVG formats. Easy EDA

allows the creation and editing of schematic diagrams, SPICE simulation of mixed

analogue and digital circuits and the creation and editing of printed circuit board layouts

and, optionally, the manufacture of printed circuit boards.

Subscription-free membership is offered for public plus a limited number of private

projects. The number of private projects can be increased by contributing high quality

public projects, schematic symbols, and PCB footprints and/or by paying a monthly

subscription.Registered users can download Gerber files from the tool free of charge; but

for a fee, Easy EDA offers a PCB fabrication service. This service is also able to accept

Gerber file inputs from third party tools.

Figure 2.14: Easy EDA Software Interface

https://en.wikipedia.org/wiki/Electronic_design_automation
https://en.wikipedia.org/wiki/Circuit_diagram
https://en.wikipedia.org/wiki/Simulation
https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Bill_of_materials
https://en.wikipedia.org/wiki/Gerber_format
https://en.wikipedia.org/wiki/SPICE
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CHAPTER 4
THE DESIGN METHODS AND PROCEDURES

4.1 Methodology

 In this project we use a solar panel for primary power source. Here also use an

Arduino Pro Mini, LDR Sensor, Servo Motor and 7.4V Battery.

 This solar panel detects sunlight automatically built-in LDR sensor, an LDR sensor

operated by the micro-controller (Arduino Pro mini). This micro-controller also

operates a servo motor to rotate solar panels horizontally and vertically. The main

work of this project is when the sun is incident in the solar panel then it will charge

and store in a 7.4v battery. Then we use a buck converter to convert 7.4v to 5v for

operating the micro-controller. this micro-controller runs on a 5 DC volt.

 We have experimented with 3 types of solar panels to compare efficiency, namely

normal axis, single axis, and dual axis solar panels.

 On the normal axis, we keep the dual and single axis closed and the solar panel fixed.

We used 18 watts of intensity as input. We measured the output from our solar panel

after certain minutes with a multimeter. We take data until our rechargeable battery is

0-100% charged. By recording that data from there we are able to get the average

output of a normal solar axis. And finally, we get efficiency from the normal solar

axis.

 On a single axis, we were able to get an average output using 18 watts of intensity

with the solar system in one-axis mode. And finally, we got comparatively more

efficiency than the normal axis.

 Similarly, in the dual axis, we used an 18-watt intensity and determined the data by a

multi meter after a certain time. Compared to the normal axis and single axis, we got

a higher average output on the dual axis. And finally, from the dual axis, we are able

to get comparatively more efficiency.
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Figure 4.1: Experimental Setup Image

4.2 Block Diagram

Figure 4.2: Block Diagram of our Project
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4.3 Schematic Diagram

Figure 4.3: Circuit Diagram of Our System

4.4 Working Principle
In this project, we use a 6v solar panel as a primary power source. This solar panel detects

sunlight automatically built-in LDR sensor, an LDR sensor operated by the micro-

controller (Arduino Pro mini). This micro-controller also operates a servo motor to rotate

solar panels horizontally and vertically. The main work of this project is when the sun is

incident in the solar panel then it will charge and store in a 7.4v battery. Then we use a

buck converter to convert 7.4v to 5v for operating the micro-controller. this micro-

controller runs on a 5 DC volt. Finally, we added a single feature light that runs on DC

current.
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4.5 Project Prototype Image

Figure 4.4: Our Final Project Prototype

4.6 Project Cost Analysis

Table 02: Required Instrument Cost Analysis

Sl. No Particulars Specification Qty. Unit

Price

(Taka)

Total

Price

(Taka)

01 Arduino Pro Mini 1 580 580

02 Solar Panel 5Watt 1 450 450

03 Buck Converter LM2596 1 130 130

04 Battery 3.7V 2 100 200

05 Servo Motor MG996R 2 400 800

06 LDR 5V 4 10 40

07 Others 1860

Total 4060/=
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CHAPTER 5

RESULTS AND DISCUSSION

5.1 Data Table

STATIONARY/NORMAL SOLAR SYSTEM

SL
No.

Time Battery
Charge

Solar
Volt(watt)

Ampere Pout(volt*amp)

1 After 14 min 0.25v 0.855w 0.30A 0.256w
2 28 min 0.50v 0.957w 0.33A 0.315w

3 42min 0.75v 1.03w 0.35A 0.361w

4 56min 1.0v 0.90w 0.31A 0.278w

5 70min 1.25v 0.78w 0.27A 0.210w

6 84 min 1.5v 0.976w 0.33A 0.322w

7 112 min 2.0v 1.14w 0.38A 0.434w

8 140 min 2.5v 1.21w 0.42A 0.511w

9 168 min 3.0v 1.48w 0.49A 0.72w

10 196 min 3.5v 1.386w 0.45A 0.623w

11 224 min 4.0v 1.28w 0.41A 0.524w

12 252 min 4.5v 1.575w 0.50A 0.787w

13 280 min 5.0v 1.76w 0.55A 0.97w

14 308 min 5.5v 1.67w 0.52A 0.870w

15 336 min 6.0v 1.86w 0.57A 1.05w

16 364 min 6.5v 1.935w 0.59A 1.414w

17 378 min 6.75v 1.98w 0.60A 1.188w

18 392 min 7.0v 2.158w 0.65A 1.40w

19 406 min 7.25v 2.108w 0.62A 1.306w

20 415 min 7.4v 2.03w 0.58A 1.177w

⸫ Average Pout = 14.437/20 = 0.721W
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SINGLE AXIS SOLAR TRACKER

SL
No.

Time Battery
Charge

Solar
Volt(watt)

Ampere Pout(volt*amp)

1 After 5 min 0.1v 1.152w 0.36A 0.414w
2 25 min 0.5v 1.306w 0.42A 0.548w

3 50 min 1.0v 1.212w 0.38A 0.46w

4 75 min 1.5v 1.14w 0.35A 0.399w

5 100 min 2.0v 1.32w 0.40A 0.528w

6 125 min 2.5v 1.512w 0.42A 0.635w

7 150 min 3.05v 1.62w 0.48A 0.78w

8 175 min 3.50v 1.47w 0.44A 0.64w

9 200 min 4.0v 1.82w 0.52A 0.9464w

10 225 min 4.45v 2.017w 0.57A 1.15w

11 250 min 4.95v 2.13w 0.59A 1.25w

12 275 min 5.50v 2.485w 0.67A 1.664w

13 300 min 6.0v 2.59w 0.70A 1.81w

14 325 min 6.5v 2.597w 0.68A 1.765w

15 350 min 7.0v 3.081w 0.79A 2.43w

16 370 min 7.4v 3.157w 0.82A 2.58w

⸫ Pout Average = 17.99/16 = 1.124W
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DUAL AXIS SOLAR TRACKER

SL
No.

Time Battery
Charge

Solar
Volt(watt)

Ampere Pout(volt*amp)

1 After 10 min 0.4v 2.33w 0.58A 1.351w
2 20 min 0.8v 2.41w 0.60A 1.446w

3 30 min 1.2v 2.132w 0.52A 1.108w

4 40 min 1.6v 1.7w 0.40A 0.68w

5 50 min 2.0v 1.88w 0.44A 0.827w

6 60 min 2.4v 2.44w 0.56A 1.366w

7 70 min 2.8v 3.03w 0.70A 2.121w

8 80 min 3.2v 3.18w 0.72A 2.28w

9 90 min 3.6v 2.97w 0.66A 1.96w

10 100 min 4.0v 2.68w 0.58A 1.554w

11 110 min 4.6v 2.596w 0.55A 1.4278w

12 120 min 5.0v 2.35w 0.49A 1.1515w

13 130 min 5.4v 2.64w 0.54A 1.425w

14 140 min 5.8v 2.92w 0.60A 1.752w

15 150 min 6.2v 3.81w 0.79A 3.009w

16 160 min 6.8v 3.68w 0.77A 2.833w

17 170 min 7.0v 4.06w 0.82A 3.32w

18 180 min 7.4v 4.14w 0.89A 3.684w

⸫ Average Pout = 33.2953/18 = 1.85W



30

5.2 Result

Stationary/Normal Axis Efficiency

η = ����/��� × 100% Here,

= 0.721/18* 100% ���= 18W

= 4.0% ����= 0.721W

Single Axis Efficiency

η = ����/��� * 100% Here,

= 1.124/18* 100% ���= 18W

= 6.24% ����= 1.124W

Dual Axis Efficiency

η = ����/��� * 100% Here,

= 1.85/18* 100% ���= 18W

= 10.27% ����= 1.85W
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5.3 Graph:

Figure 5.1: Time vs Pout Graph in Different Solar Mode

Figure 5.2: Efficiency Graph
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5.4 Advantages
There are certainly many advantages of our project and some of the major ones have been

given below:

 The power sources are natural and the battery is rechargeable.

 Less power consumption with best utilization.

 The whole system is automatic and saves energy by detecting the presence of light.

 The system is user friendly.

 The system is good for the environment as it utilizes renewable energy sources.

5.5 Application
Our project has many application areas and actually we need to use it in many places to

verified the exact person which have the proper access. Some of the application areas of

the project has been pointed out below:

 The system can be implemented to work on different projects.

 It can be implemented in area where power wastage takes place a lot.

 It can be implemented in areas where there’s power shortage.

 This system can work to power almost anything that runs on electricity

5.6 Limitation
Although our project has many applications and advantages but there are some limitations

of the project as well and the good thing is that these limitations are minor and doesn’t

affect the efficiency of the system. Limitations are given below:

• The system needs to be more efficient to produce more energy.

• Due to using renewable energy sources, electrical energy production is less and

most of the energy is not converted rather wasted.

• On rainy days, foggy weather and some problems may occur which can hamper

energy production.

• Since the input power (18W light) is relatively large from the solar panel, the

maximum power is spread around, so the solar panel is not able to absorb its

desired power, so we do not get proper efficiency
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5.7 Discussion
While working on our project, we did face some difficulties as it is a very complex

system but the end results, we came up with were quite satisfactory. We have put the

whole system through several tasks to validate our work and also have taken necessary

notes for future improvements. Some future recommendations that we have involves

improvement in system design and wiring, adding features for more efficient.
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CHAPTER 6

CONCLUSION

6.1 Conclusion
We presented a means of dual axis solar tracking system continually orient PV panels

towards the sun with the help of Micro controller, LDR sensor, and Servo Motor in the

PV system. Average power gain of dual axis solar tracker. In the long run this project will

be beneficial, and sustainable for water bodies area. Dual axis PV system provide the

reasonable solution for limited land resource and creating clean and emission free power

generation.

6.2 Future Scope
We are thinking about adding many features to our project in the future to get more

desirable outcomes. Some of the steps that we are thinking about taking are given below:

 In the future we are looking forward to improved of our whole system design to make

it more efficient.

 In the future this tilting mechanism with a collector can be implemented on large

solar plants and also can be operated automatically.

 This mechanism can be implemented on solar cookers, ovens, carriers and on thermal

solar heaters.
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Appendix

Micro-Controller Programming Code:

#include <Servo.h>

#include <Wire.h>

float input_voltage = 0.0;

float temp=0.0;

float input_voltage1 = 0.0;

float temp1=0.0;

// horizontal servo

Servo horizontal;

int servoh = 90;

int servohLimitHigh = 180;

int servohLimitLow = 0;

Servo vertical;

int servov = 90;

int servovLimitHigh = 180;

int servovLimitLow = 0;

// LDR pin connections

int ldrTR = A3; // LDR top right

int ldrTL = A2; // LDR top left

int ldrBR = A1; // LDR bottom right

int ldrBL = A0; // LDR bottom left

/*// LDR pin connections

int ldrTR = A2; // LDR top right
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int ldrTL = A3; // LDR top left

int ldrBR = A0; // LDR bottom right

int ldrBL = A1; // LDR bottom left

*/

int dtime ; // change for debugging only

int tol ;

int avt ; // average value top

int avd ; // average value bottom

int avl ; // average value left

int avr ; // average value right

int dvert; // check the difference of up and down

int dhoriz; // check the difference of left and right

int tr ; // top right

int tl ; // top left

int br ; // bottom right

int bl ; // bottom left

int analog_value ;

int analog_value1 ;

float t1 ;

void setup() {

// put your setup code here, to run once:

Serial.begin(9600);

pinMode(A6,INPUT);

horizontal.attach(10);

vertical.attach(9);

// move servos

horizontal.write(50);
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vertical.write(50);

delay(500);

}

void loop() {

// put your main code here, to run repeatedly:

int tr = analogRead(ldrTR); // top right

int tl = analogRead(ldrTL); // top left

int br = analogRead(ldrBR); // bottom right

int bl = analogRead(ldrBL); // bottom left

//int analog_value = analogRead(A6);

//int analog_value1 = analogRead(A7); ///solar voltage print

//input_voltage = (analog_value * 8.0) / 1024.0;

//input_voltage1 = (analog_value1 * 5.0) / 1024.0;

//float batteryvoltage = input_voltage1*8;

//lcd.setCursor(0, 0);

//lcd.print("Solar: ");

//lcd.setCursor(6, 0);

//lcd.print(input_voltage );

tr = analogRead(ldrTR); // top right

tl = analogRead(ldrTL); // top left

br = analogRead(ldrBR); // bottom right

bl = analogRead(ldrBL); // bottom left

dtime = 0; // change for debugging only

tol = 50;

avt = (tl + tr) / 2; // average value top

avd = (bl + br) / 2; // average value bottom

avl = (tl + bl) / 2; // average value left

avr = (tr + br) / 2; // average value right
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dvert = avt - avd; // check the difference of up and down

dhoriz = avl - avr; // check the difference of left and right

Serial.print(tl);

Serial.print(" ");

Serial.print(tr);

Serial.print(" ");

Serial.print(bl);

Serial.print(" ");

Serial.print(br);

Serial.print(" ");

Serial.print(avt);

Serial.print(" ");

Serial.print(avd);

Serial.print(" ");

Serial.print(avl);

Serial.print(" ");

Serial.print(avr);

Serial.print(" ");

Serial.print(dtime);

Serial.print(" ");

Serial.print(tol);

Serial.print(" ");

Serial.print(servov);

Serial.print(" ");

Serial.print(servoh);

Serial.println(" ");

if (-1 * tol > dvert || dvert > tol) {

if (avt > avd) {

servov = ++servov;

if (servov > servovLimitHigh) {

servov = servovLimitHigh;

}
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}

else if (avt < avd) {

servov = --servov;

if (servov < servovLimitLow) {

servov = servovLimitLow;

}

}

vertical.write(servov);

}

if (-1 * tol > dhoriz || dhoriz > tol) {

if (avl > avr) {

servoh = --servoh;

if (servoh < servohLimitLow) {

servoh = servohLimitLow;

}

}

else if (avl < avr) {

servoh = ++servoh;

if (servoh > servohLimitHigh) {

servoh = servohLimitHigh;

}

}

else if (avl = avr) {

// nothing

}

horizontal.write(servoh);

}

delay(dtime);

}
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